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Creating New Files

To create a new file you first must give it a name. Enter a filename into the dialogbox (8 characters at 
most, the extension '.DBF' is appended automatically).

Next you need to define a set of fields which determine the structure of the new database. Give each 
field a name as well. The names need not be unique, however this might be useful if you want to access 
the data from other applications. Then you must provide the size of each field. Simply enter the values 
into the boxes - the maximum size of a single field is 254 (characters), I recommend a maximum size of 
65 because that is what fits on the screen.

If you want to define a date field do not enter figures but the letter ' d ' instead - this makes EZB create a 
field with the internal size of 8 bytes (yyyymmdd) but a display size of 10 (dd.mm.yyyy - the international 
date format).

There are two special field codes if you want to display graphics or text files from within EZB. ' g ' defines 
a link field for displaying grafics and ' t ' for displaying text files. Just enter the appropriate letter. A field 
length of 12 is generated automatically (8 characters for entering the file names, one for the dot, 3 for the 
file extensions).

EZB can handle up to 20 fields.

That's it! All fields with the exeption of ' g '- and ' t '-fields will be indexed automatically.



Opening a File

Files are opened using the Windows standard dialog. The default extension is 'DBF'. EZB files are 
compatible to dBase files.

You also can use a file's name as argument when calling EZB. The database then is loaded immediately 
when EZB comes up.

You can access non EZB database files, but EZB will only display the first 20 fields of each record, in 
case there should be more. Also you can neither use the fast indexed search, nor store or delete records. 
But you can browse the database, conduct a freetext search or write data to lists.



Closing Files / Exiting EASY-Base

You may use the Close command from the File menu to close a file. All files (original data, parameters 
and index) will then be updated on the disk.

An opened file is closed automatically when you open another file or create a new one or exit EZB 
(using the menu option or the system bar).

EZB can only handle one file at the same time. 



Rebuilding the Index

EZB creates and maintaines one index file for each database. Each field you have defined is indexed 
automatically. The entries in the index file are updated automatically when you append, replace or 
delete data.

Normally you need not bother about the index file.

The menu option Reindex might be useful, however, after data losses have occured or after importing 
data. When you have imported data or read in disk contents by using EASYDISK not the complete 
database will be reindexed but only new index entries for the appended records will be added.



Reorganizing Data

EZB reorganizes data automatically: the index is maintained automatically, and free disk space after 
deleting records is used for those newly entered. 

Normally you can forget about this menu option.

The Reorganize command 'packs' the data and sorts the database on the first field. As the reorganization
uses the index never start "Reorganize" when the index is corrupted. In this case Reindex the 
database first.

A reorganization can take pretty long depending on the number of records in the database, the number of 
fields and the size of the file. Note that after choosing this option the index is rebuilt automatically, too.



Searching / Sorting

To retrieve data type in the beginning of a character string into the field you want to search. Then press 
the [Return] key or click the '<=' symbol of the menu bar or choose the Find option from the Record 
menu.

EZB always does a stem search. You do not need wildcards. Just type in the first few letters. The search 
is not case sensitive either.

When you browse the data you will notice that the records are sorted on the field you chose for searching.
Each field is indexed and thus used for sorting as well.

If you want to sort on a different citeria or sort the complete database use the menu item Options - Sort. 
You have to specify the field number here (the top field is '1' the bottom field is '20' or less).

When you have filled in more than one field the search is 'ANDed'. EZB retrieves all records for which all 
conditions are true simultaniously. In this case the records are not sorted at first (with the exception of a 
newly reorganized database), but you can sort them by means of the Sort option.

You can also conduct searches for text strings independently of the field structure of a database. Access
the Options menu and select the Search item. Enter the text in the entry editor of the Search dialog box 
and click the OK button. This text search is not case sensitive either. You can even find deleted 
records (as long as they have not been replaced by new data). This option also works with non EZB 
databases. As the text search does not use the index file it may take a while, depending on the size of 
the database.

Again you will get a selection of all records where a match is found. You can sort the data choosing the 
Sort item in the Options menu (non-EZB data cannot be sorted because the sort option makes use of the
index file).

There are extended search facilities for date fields. Here you can specify all records from a date (>=    -
condition) or before a date (<    -condition). Or you can search all records for a year specified or a month 
and so on.

You have to enter the internal date format for this which goes yyyymmdd and you must specify an 
operator (' = ', ' < ' or    ' > ', where the latter actually means ' >= ').
Your entries in the searchfield might look like this:

>19940101
<1994
=199312
=1993

The search is truncated like always: '199312' means all data from December 1993, '1993' means the 
complete year 1993.

Of course you can also search for a single date. Type in the  international date format (dd.mm.yyyy) in 
this case:

1.4.94

searches all records wich have the first of April in the date field. You can omit leeding zeroes.

Finally a database may contain multiple-indexed fields. Although    this field type cannot be specified in 
EZB you can profit from it in preconfigured databases. Here single entries which are separated by ' ; ' or 



' ;    ' (semicolon or semicolon-blank) can be searched independently. This feature is typically used for 
keywords, search terms (controlled terms, supplementary terms), classification codes, also author fields 
and so on. You will find further information in the Readme files accompanying predefined databases 
which use this option (like 'LIT' which comes with this packet).



Browsing the Database

You can browse the database by either pressing the [PgDn]- or [PgUp]-keys or clicking the ' >> ' 
respectively ' << ' symbol from the menubar.

This works similarly after you have conducted a search. In this case you browse the selection of matching
records.

When you open a file the data are not sorted at first. After conducting a search, however, the records are 
sorted on the search field. Alternatively you can sort the data selecting the Sort command from the 
Options menu.



Storing / Appending / Replacing records

Enter the data into the field editors displayed on the screen and press the [Ins] key or click    '=>' at the 
menu bar or choose the Store command from the Record menu.

When you have entered the data into an empty screen the record is appended to the database. Have 
you displayed a record first and then changed some of the data the original record is replaced with the 
new one. This is normally what you want to do.

However, to make sure that a record is added to the database rather than replacing the one you just 
displayed, use the [ + ] key (from the numerical keyboard pad) or the Append option from the Record 
menu instead. Thus you can duplicate data.



Deleting Records

You can only delete records which are currently being displayed on the screen: conduct a search first or 
browse    the database until the record in question is displayed. Then press the [ - ] key (from the 
numerical keyboard pad) or select the Delete command from the Record menu. A dialog box is displayed
then for confirmation.

The records are only deleted 'logically' at first. They remain in the database until you enter new data and 
the disk space is reused for this. As long as you do not enter new data you can retrieve deleted records 
either browsing the database or running a text search (Options - Search). Replace the ' ? ' at the 
beginning of the record and press the [ + ] key (from the numerical keyboard pad) or choose the Append 
command from the Record menu to restore the record. [Ins] or '=>' might not work correctly here.



Listing Records

The List command from the Record menu outputs the record currently being displayed to a file called 
<name>.LST (the name of the database with the extension 'LST'). A record is listed like it is shown on the
screen. When you have altered any data these alternations will be in the list as well. This can be 
convenient when you want to address varying persons in the same organization without having to keep 
duplicate address entries in the database for each.

The output is formatted depending on your entries in the report parameter file. The default settings are: 
one line per data field and an extra line feed at the end of each record    (a form feed, when printing single 
records).

When you open the same database again the <name>.LST file is newly created. Former selections will be
lost. The lists are only meant for temporary storage.

Selecting the List All item from the Options menu you can also list all records from the current selection. 
This is either the complete database or just part of it when you have conducted a search first.

Two further options are "List all (DEL)" and "List all (SDF)". Both ignore your entries in the parameter file
and list all fields instead. As for 'List all (DEL)' trailing blanks are ignored, each field is succeeded by the 
delimiter as defined in the parameter file, and a carriage return/line feed sequence is appended to each 
record.    This format is often used for printing serial letters.

'List all (SDF)' outputs the data in the structured data format, which means with all trailing blanks 
included and a line feed at the end of each record. Thus you get a table format which can easily be 
imported by other programs.



Printing Records

When you select the Print command from the Record menu the record currently being displayed is 
printed on the default printer. The formatting depends on the report parameters.

You can also choose "Print All" from the Options menu. In this case all currently selected records    will 
be printed. I have not provided a Cancel option - so use this feature cautiously! Single records will be 
separated by a    line feed    (which makes an empty line if you also have defined a line feed as suffix 
code) and a form feed is appended at the end of the list.



Copying Records to the Clipboard

You can transfer data to other applications like your favorite word processor selecting the Copy 
command from the Record menu.

The record currently beeing displayed will be formatted according to the report parameters and copied to 
the clipboard. 



Displaying Graphics or Text Files

EZB allows you to display images or text files from within a database by means of calling other 
applications. To enable this feature special field types must be defined: ' g '-fields for viewing graphics 
respectively ' t '-fields for viewing text. EZB then generates editor lines with field lengths of 12 characters 
for entering file names into the database.

When pressing the [Return] key while the cursor is active within such field the appropriate program is 
called with the fields contents as parameter. You can let EZB call your favorite viewing programs 
providing a file "EZB.PAR" in the working directory. The first entry (line) in this file defines the viewer for 
graphics the second the viewer called when displaying    text. If    "EZB.PAR" is missing, EZB uses 
PAINTBRUSH respectively NOTEPAD as default viewers.



Editing Data / Clearing the Screen

For each field defined in a database EZB creates one line on the screen which is used as well for entering
new data as for searching.

You can move the cursor to the next field by pressing the [Tab] or [Cursor down] key. Move one line/field 
up with [Cursor up]. Alternatively you can activate the editor line of a field clicking the left mouse 
button.

To clear the entire screen press the [Home] key or click    the Clear command on the menu bar.



Defining Report Parameters

You can set up your own report parameters selecting the Design Reports item from the Options menu. 
The parameters you define here are used for output    to lists as well as for copying data to the clipboard 
or printing.

To select the fields which shall be listed or printed, you have to enter field numbers instead of field 
names. The top field on the screen is number '1' the bottom one number '20' or less depending on the 
number of fields defined in the database. The field numbers are displayed in the first column of the 
screen. You can end the list by just entering an invalid field number in the next box - '0' for example. The 
following entries in the table will then be deleted automatically when the parameters are being stored.

The default is that all fields are listed or printed.

The field sequence for reports may differ from the screen layout. You could also list fields repeatedly.

Each field can be preceeded by a prefix and succeeded by a suffix when listed. The default value for the
suffixes is a line feed. With MS-DOS systems a line feed consists of two characters: one for 'carriage 
return' and one for 'line feed'. EZB uses \r as code for a carriage return character and \n for a new line. 
You can also append ordinary characters or space characters as well. Or use \t  (tabulator) for formatting
the output.

Tabulator characters and form feeds are ignored when you print records. When printing single records a 
form feed is appended anyway. When printing lists single records are separated by empty lines and a 
form feed is appended at the end.

Using prefixes allows you to produce output like this:

AU    = [author name]
TI        = [book title]
SO    = [source information]

Once again: important suffix codes

\r\n line feed
\t tabulator

The output is always 'delimited'. Trailing space characters are cut off, fields with no contents are 
ignored. To prevent field contents from beeing glued to each other you always should provide a suffix. 
Often a space character does the trick. Or use \t for formatting text especially with regard to proportional 
fonts.

You can also define a    delimiting character (the default delimiter is ' ; '). This is appended when listing 
all records of a selection with the "List all (DEL)" option. The delimiter will also be listed when there is no 
entry in a field. Thus you can rely on a fixed number of delimiters (fields), which is important when 
exporting data for serial letters etc.



Importing Data

This fuction is not yet implemented. A later version will allow you to import dBase compatible files and 
structured ASCII files (extensions 'DBF' and 'SDF').



Quick Reference

Several keys (accelerator keys) serve as shortcuts for menu options or mouse actions, these are:

[Return] search / display images, text files or other databases
[Tab] jump to next field
[Cursor down] jump to next field
[Cursor up]      jump to previous field
[PgDn] display next record
[PgUp] display previous record
[Home] clear screen
[Ins] store a record
[ + ] (numpad) append a record
[ - ] (numpad) delete a record
[F1] help
[Esc] exit EZB



Messages

EZB uses default settings which make working with the program quite simple and straightforward. When 
you have displayed a record, altered data and then store it, EZB replaces the old record with the altered 
one. When storing a record after entering data into an empty screen layout a new record is created. 
Listing, printing or copying a record always means exporting the record like it is shown on the screen (not 
like it may be stored in the database). A search is always a combined search when you have filled out 
more than one field. When you choose just one data field for searching the hit list is sorted on this very 
field. 

In 99% what EZB does is what you want it to do.

Nonetheless you may encounter one of the following information or error messages:

Maximum length of a field is 254 characters
You have tried to define a data field which is longer than 254 characters (bytes). Enter a value of 254 or 
less to make EZB happy again.

File already exists - use a different name
You have tried to create a new database using a name which already is in use for another. Either choose 
a different name or delete the existing database first (files: <name>.DBF, <name>.PAR and 
<name>.IDX ).

Cannot open the file
This should never happen. Possibly the file in question is read-only.

Invalid file format - not a DBF-file?
Are you sure this file is in the dBase (TM) format?

Cannot display the dialog box
This should never happen either. Maybe you should close some other application to make Windows (TM) 
work properly again.

GetOpenFileName returned error-no. ...
Some Windows (TM) error message I never actually encountered.

No record found
You have conducted a search which brought up no hits.

First or last record of current selection
While browsing the complete database or your current selection (hit list) you have come to the first or last 
record in the list.

Record must be displayed prior to deleting
Record must be displayed prior to output
EZB does not know which record you mean. Bring it up to the screen first. After entering new data a 
record must be stored first before it can be listed or printed.

Invalid field number
You have entered a field number which is not defined in the database (a value of    0 or greater than the 
number of fields in your database). Try again.

Not an index/sort field
When you have defined your database using EZB all fields are indexed automatically. There may exist 
predefined databases though which also comprise non-indexed fields (note fields for example). Link fields



for displaying images or text files are not indexed either.

Error during sort
Possibly there is no record in the database (the display box says "0 of 0 selected"). Or there might be not 
enough space in the RAM of your computer. As this is very unlikely - EZB only needs 30 K to 400 K of 
RAM, depending on the number of records in the database -, I would like to be informed. Add a few 
informations like how many records are in the database, how many did you try to sort, does the sort work 
properly when you choose another field ... My Compuserve-ID is 100303,221.

This function is not yet implemented
The import feature will be implemented in a later version of EZB (registered users don't have to pay 
update fees).

Could not call Program/Viewer
Very likely the program you use for displaying images or text files is either not defined in 'EZB.PAR' or is 
not in a current path.



General Information

Features/Limitations:

any number of databases
a maximum of 65,534 records per database
a maximum of 20 fields per record
a maximum of 254 characters per field

field types: indexed field or indexed date field
(multiple indexed fields are interpreted correctly)
'link' - fields: ' g ' (for viewing graphics), ' t ' for viewing text files'
and ' l ' for accessing other EZB-database files

hierarchical index for all fields
with a maximum of 1,3 million entries
the first 10 characters of each field are used for indexing

automatic standard screen layout for editing and displaying data

Files:
*.DBF original data
*.PAR parameter file
*.IDX index

*.LST temporary list file
*.LSP report parameters
*.TMP      temporary file during reorganization

planned future developments:

import of SDF and DBF files
direct conversion for DBF files
export of database structures

Notes

EZB does not support networking or multiple access to databases at the same time. To make sure, that 
each database is opened only once, you should run SHARE.EXE when running EZB (you can start 
SHARE from the AUTOEXEC.BAT or when before starting Windows).

When you use to work in one particular database most of the time (e.g.    ADR.DBF ), you should    set up 
a second item for EZB and use the database's name as an argument when calling EZB ('C:\DBPROG\
EZB    ADR.DBF'). The database then is loaded immediately.



License

EZB is distributed free of charge for evaluation purposes only. If you like EZB and plan to use it for longer 
than 30 days you are expected to pay a registering fee of    $15.    Once you have paid this fee you are 
entitled to use EZB as long as you like and update it as often as you like - and as long as there are any 
updates - without paying any additional fees. If you need my support or have any questions write a 
mail to my Compuserve-ID    100303,221 (registered users only). You can register electronically at 
Compuserve: GO SWREG and search for EZB as a keyword.

Although I have tested EZB on different computers in different environments I cannot garanty the program
to work with any configuration. Registration is only required when proved to run satisfactorily on your 
machine.

Bernd Harmsen
Stuttgart,    Germany - November 1994




